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PREFACE

INTRODUCTION
O Autodesk® AutoCAD® has been the de facto drafting tool for PC users since
1982. As you read this, millions of engineers, draftsmen, project managers,
and engineering students are creating their drawings with AutoCAD.
¢ This book introduces new and novice users to AutoCAD 2010, covering both
Level 1 and Level 2 concepts. It is also a very handy tool for college and
university drafting instructors using AutoCAD 2010.
*  Currently, about 75% of current AutoCAD 2010 users regularly apply
the core Level 1 commands for AutoCAD 2010.
¢ This book will not teach what engineering drafting is or how to produce
it; knowing drafting and design concepts are prerequisites for using this
book.
O This text can be instructor-led or self-taught.
O At the end of each chapter, you will find Chapter Review questions that will
help you practice and test your mastery of the material.
O There are 94 exercises integrated throughout the book to help you quickly

implement what you have learned. The first half of the book contains
21 workshops that, together, will complete a full project (a small villa),
starting with the creation of the project through plotting. Solving all
94 exercises will teach you to:
e Simulate a real-life project from beginning to end, thereby allowing
you to implement what you have learned.
e Learn all of the basic commands and functions in AutoCAD 2010.

e Apply advanced Level 2 concepts in real-world scenarios.
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PURPOSE AND OBJECTIVES

O At the completion of this book, readers will be able to:
e Understand AutoCAD 2010 and its basic operations, including the
filing system
e Draw different objects with speed and precision
e Set up drawings and construct them in simple steps
* Modify any object in a drawing
e Create, insert, and edit blocks
e Hatch using different hatch patterns and methods
e (Create text and tables
e Insert and edit dimensions
* Prepare and plot a drawing
e Create dynamic blocks
e Create, edit, and extract block attributes
e Use the External Reference feature to collaborate with teams
e Understand sheet sets
* Use basic, intermediate, and some advanced layer functions
e Utilize Autodesk Design Review software for markups
e Use the AutoCAD Markup Set Manager

PREREQUISITES

O The author assumes that you have experience using computers and the
Microsoft® Windows® operating system.

O Also, readers should know how to start new files, open existing files, save
files, use “Save As” with files, close files with or without saving, and exit
software.

O Because these commands are similar in all software packages, the author does

not cover these subjects unless it is necessary to demonstrate a command
specific to AutoCAD.
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ABOUT THE DVD

¢ A DVD is included with the book and contains the following:

The AutoCAD 2010 trial version, which will last for 30 days starting
from the day of installation. This version will help you solve all of the
exercises and workshops in the book. Students with a valid university
email address can visit http://students8.autodesk.com/Plbon=1
for student versions of the AutoCAD material for the duration of
the class. After successfully downloading the trial version from
the DVD and starting AutoCAD 2010, users will be prompted by
an activation menu. Select “Run the product” to begin working
with this trial software. To activate your trial version, use product
key 001B1 when prompted by AutoCAD.

Exercise and workshop files, which will be your starting point to
solving all exercises and workshops in the book. Copy the Book
Exercises and Book Workshops folders onto your hard drive. You
will find two folders inside the Book Workshops folder. The first one
is named “Metric” for the metric units workshops, and the second
one is named “Imperial” for the imperial units workshops.
Selected solutions to exercises and workshops.

All images from the text in full color.






INTRODUCTION TO

Chapter AutoCAD® 2010

In This Chapter

What Is AutoCAD®?

How to Start AutoCAD® 2010
Understanding the AutoCAD® 2010 Interface
Points in AutoCAD®

AutoCAD® Default Settings

Things You Should Know about AutoCAD®
Drawing Limits

Units and Spaces

Viewing Commands

Creating a New File

Opening an Existing File

R R C R R R R R R R

1.1 WHAT IS AUTOCAD®?

AutoCAD® was one of the first Computer Aided Design/Drafting (CAD)
software applications in the world.

The first version of AutoCAD was released at the end of 1982, and it was
designed to be used only on PCs.

Since 1982, AutoCAD has increased dramatically on a global scale.

Users can draw both two-dimensional (2D) drawings and three-dimensional
(3D) designs in AutoCAD.

There is another version of AutoCAD called AutoCAD LT that is dedicated
to 2D drafting only.
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1.2 HOW TO START AUTOCAD® 2010

®  There are two ways to start AutoCAD 2010:
I} e While installing AutoCAD 2010, the installation program will create a
AUDCAD 2010 shortcut on your desktop. To start AutoCAD, simply double-click this icon.
* From the Windows taskbar click Start/All Programs/Autodesk/
AutoCAD2010/AutoCAD2010.
" AutoCAD will start with a new, open drawing file, which will look like the

- English

following:
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1.3 UNDERSTANDING THE AUTOCAD® 2010 INTERFACE

®  The primary methods to reach commands in AutoCAD 2010 will be through
Ribbons and the Application Menu.
You will use Ribbons instead of the normal toolbars.
This interface will give you more space in the Graphical Area, which is
your drawing area.
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Application Menu
= (Click on the Application Menu, and you will see the following:

l

Lt = Open a file

D New 3 ﬁ" Drawing

Opens an existing drawing filz

=
L&~ |

Sheet Set
E e @ Opens a sheet set data file in the Sheet
Set Manager

Save is b
= e

| Imports the data from a DGN file into a

DGN  new DWG file
B Export 4

Options Exit AutoCAD

®  Using this menu, you can:
e Create a new file
* Open an existing file
e Save the current file
o Save the current file under a new name (Save As) and/or in a different folder
e Export the current file to a different file format
e Print the current file
e Publish the current file
¢ Send the current file to eTransmit or email
e Use all the functions related to your drawing
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¢ C(Close the current file
e Exit AutoCAD

Quick Access Toolbar

®  The Quick Access Toolbar is the small toolbar located at the top left of
the screen:

BE A A=

®  Using this toolbar, you can:
e Create a new file
* Open an existing file
e Save the current file
¢ Undo and redo
e Print the current file

Ribbons

= Ribbons consist of two parts:
e Tabs
e Panels

= For example, the Home tab consists of eight panels: Draw, Modify, Layers,
Annotation, Block, Properties, Utilities, and Clipboard.
In each tab you will see different panels.
The following is the Draw panel:

®  Some panels (such as the Draw panel) have a small triangle near the title,
which indicates that there are more buttons available. If you click on it you
will see the following:

il >

@ - =
Line CE’)—
Tl s 1] Pl Bl
| 1% || (B3 [T %
AEO

Draw
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® At the lower left-hand corner of the panel you will see a small pushpin. If
you click on it, this will be the default view. To return to the previous view,

simply click the pushpin again.

ol ]| Pl R,
USR]
2 E O
Draw

®  Some panel buttons may have a small triangle just to the right, which means
there are additional options, as shown here:

(D ot
O Axis, End

Q Elliptical Arc

= Ifyou hold your cursor over any button for one second, a small help screen
appears:

Line

Creates straight line segments

[ LINE

Press F1 for more help
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= However, if you hold your cursor over the button for three seconds, you will
see an extended help screen:

Pt
/o=
Lin @EE

Line
Creates straight line segments

Wiith LINE, you can create a series of contiguous line segments. Each
s=gment is 3 line object that can be edited separately.

—"

b

[ LINE

Press F1 for more help

= Panels can be docked or floating. By default, all panels are docked. To make
a panel a floating panel, simply click on the name of the panel, hold it, and
drag it to its new location.

= If all panels remain docked, you will not see any panel outside the tab it
belongs to. But if you make any panel a floating panel, then you will be able
to see it in all other tabs.

= While the panel is floating, you will see two small buttons on the right-hand
side. The following image shows the function of each one:
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®  All panels have two orientations: a vertical orientation and a horizontal

orientation. The following illustration shows the tabs and panels that appear
for both orientations.

Falilha)
@ || =
Line ®1§E

/f'-,:n 6|11 |
M= B[] |
Line @vlg :@§©

Draw « % | Draw

r== o P AP
/ @- o Mo 81
e e g &E O F

N
A4

720U

Draw

Line

The number of tabs and panels are predefined by default.

You can turn off/on any tab/panel by right-clicking on any tab/panel and then
selecting the desired tab/panel to be turned on or off.

! Tabs » i
E v Modify
v Layers
« Annotation
« Block
v Properties
« Utilities
v (Clipboard

= Ribbons have three different shapes. You can alter the shapes by clicking

the small arrow at the right:

Insert Annotate  Parametric  View  Manage  Cutput

S0 . BODR-ESE8E 28 59

+ | |
| “iine @ D‘: vove DN & Ah | | nsved Layer otz |
T e-m " 4ema- gsams
I Draw | Modify - i Layers :

Insert Annotate  Parameinc View  Manage

| Draw | Modify | Layers | Annotation | Block | Properties « | Utilities | Clipboard |
el . . | : | : |

GRS Insert Annotate  Parametric  View  Manage — Ouiput =
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InfoCenter

® At the top-right part of the screen, you will see the InfoCenter:

I Type a keyword or phrase

®  The InfoCenter gives you the opportunity to type in keywords that will
enable AutoCAD to search both online and offline resources and provide
you with a list of related help topics. See the following example:

arc 2

dinC X
|
=

AutoCAD Help

User's Guide = ||
@ Change Existing Objects |

(F) Construct Meshes from Other Objacts
(Concept)

(@) Balance Mesh Density for Smooth Geometry
(Concept)

@ To alter the display resolution of arcs and
circles (Procedura)

(3) Draw Geometric Objects
Command Reference =0 |
{#) REVCLOUD (Quick Referance)
(3) BCPARAMETER (Quick Reference)
(3) MEASUREGEOM {Quick Reference)
(3) DIMCOMSTRAINT (Quick Referance) |
(@) Symbols and Amrows Tab (Quick Reference)
Customization Guide =10]
A Codes 00C and NON: Fulne-Snecified Arcs

®  You may still use the conventional Help search by clicking the arrow at the
right-hand side of the InfoCenter:

PES TN

Help
New Features Workshop

Additional Resources 4

Send Feedback

Customer Invohvement Program...
About

Command Window

= Ifyou used AutoCAD 25 years ago, the only way to input commands was to use
the Command Window. You had to memorize all of the AutoCAD commands
and type them in. There were no menus, toolbars, panels, or ribbons. Although
you can still type in the commands, we don’t recommend that method.
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Graphical Area

®  The Graphical Area is where you do your actual drawing. You use the
crosshairs to specify points in the XY plane.
®  You can monitor the coordinates of the crosshairs using the left side of the
Status Bar.
Status Bar
®  The Status Bar in AutoCAD contains many functions that will help you
draft more precisely. We will discuss most of the buttons on the Status Bar
throughout this book.
®  There are two views for the Status Bar:
e By default (Icons)
[aBl e[« ufe|+]a]
e Buttons
| sM4P | GRID |ORTHO |POLAR | 0SNAR | 0TRACK | DUCS | D |LwT [aP]
®  To switch views, right-click the Status Bar to alternate between buttons
and icons.
v Enabled
Use Icons
Display crosshair labels
Display 3
| ]

If you select Use Icons, the view will change accordingly.

1.4 POINTS IN AUTOCAD®

Points are defined (and saved) in AutoCAD using the Cartesian coordinate
system.

The coordinates will look something like 3.25,5.45, which is the format of X,Y.
So the first and most traditional way of specifying points in AutoCAD is
to type the coordinates whenever you are asked to do so, by typing XY
(pronounced X comma Y). See the following illustration:
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1.5 AUTOCAD® DEFAULT SETTINGS

Sign convention: positive is up and right.
" Angle convention: positive is counterclockwise (CCW) starting from the east
(i.e., 0 angle). See the following illustration:

90°

1807 0°

270°

1.6 THINGS YOU SHOULD KNOW ABOUT AUTOCAD®

®  The mouse is the primary input device:
* The left mouse button is always used to select and/or click.
e The right mouse button, when clicked, offers a drop-down menu.
®  The mouse wheel has zooming functions:
* Zoom in on your drawing by moving the wheel forward.
* Zoom out of your drawing by moving the wheel backward.
e Pan (i.e., move through the drawing) by pressing the wheel and holding
it and then moving the mouse.
e Zoom to the edges of your drawing by double-clicking the wheel.
= Ifyou type an AutoCAD command or any input in the Command Window,
you have to press the [Enter] key to execute it.
[Enter] = [Spacebar] in AutoCAD.
To repeat the last AutoCAD command, press [Enter] or [Spacebar].
To cancel any AutoCAD command, press [Esc].

1.7 DRAWING LIMITS

AutoCAD offers users an infinite drawing sheet on all sides.

When you start a new AutoCAD drawing, your viewpoint will be at 0,0,1.
You are looking at the XY plane, using a camera’s lens; hence you will see part
of your infinite drawing sheet. This part is called the limits. See the following:
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oo -

In this example, you can see that the limits of the drawing are from 0,0
(lower left-hand corner) to 12,9 (upper right-hand corner). This is your
working area.

We will learn how to change limits in upcoming chapters.

1.8 UNITS AND SPACES

One of the vague facts about AutoCAD is that it does not deal with a certain

length unit while drafting. Take note of the following points:

¢ AutoCAD deals with AutoCAD units.

* An AutoCAD unit can be anything you want. It can be a meter, centimeter,
millimeter, inch, or foot.

e All of these options are correct as long as you remember your chosen
option and stay consistent in both X and Y.

Also, there are two spaces in AutoCAD, Model Space and Paper Space

(Layout). You can switch between the two spaces using the Status Bar.

e IR

Paper Space (Layout) button
Model Space button
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By default, when you start a new drawing file, you are in Model Space.

In Model Space you can create and modity your drawing.

Once you are ready to make a hardcopy of your drawing file, switch to the
Paper Space (Layouts) so you can prepare your page setup.

This is the moment you need to ask, “What is my unit assumption?” so that
you can properly scale your drawing.

We will discuss printing in a later chapter.

1.9 VIEWING COMMANDS

We already discussed using the mouse wheel for zooming in, zooming out,
and panning.

You can also zoom in, zoom out, and pan using the zooming and panning
commands.

If using Ribbons, make sure you are in the View tab, and, using the
Navigate panel, select the first button on the left, or the small arrow, to see
a list of zooming commands:

E‘f Pan

b Constrainad Orbit -

@I‘Mnduw -

Navigate

CQ Pravious
q Realtime
Al

Dynamic

Scale

. Canter

DPPPRS
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Zoom Extents is used to zoom to all objects.

Zoom Window is used to specify a rectangle. By specifying two opposite
corners, whatever is inside the rectangle will look larger.

Zoom Previous is used to restore the previous view, up to the last ten
views.

Zoom Realtime is done by clicking the left button on the mouse
and holding it. If you move forward, you are zooming in; if you move
backward, you are zooming out.

Zoom Dynamic is used with the Zoom Window first. You will see the
whole drawing and your current place (shown as a dotted green line), go
to the new location, and press [Enter].

Zoom Scale is used to input a scale factor. If you type in a number less
than 1, you will see the drawing smaller. If the scale factor you type in is
greater than 1, you will see the drawing larger. If you put the letter x after
the number (e.g., 2x) the scale will be relative to the current view.
Zoom Center is used to specify a new center point for the zooming,
along with a new height.

Zoom Object is used to zoom to certain selected objects. AutoCAD will
ask you to select objects and the selected objects will fill the screen.
Zoom In is not really a zoom option, but rather a programmed option
equal to the Zoom Scale with a scale factor of 2x.

Zoom Out is just like Zoom In, but with a zoom factor of 0.5x.

Also on the Status Bar, you can use the following two buttons:

ERQEE]

Zoom
Pan

1.10 CREATING A NEW FILE

To create a new file based on a premade template, click on the New button
on the Quick Access Toolbar:

2

Il".I'DI'Id =S L STEL T H
tEitaltallt L R T

Press F1 for more help
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The following dialog box will appear:

[ Y Select template

Loak in: | 1) Template

‘%—| ey Ca B Mews + Took w

'|

(%]

Freview

Mame = Siz |
CIPTWTemplates
|5)SheetSets

T acad &9 k|
|eam)acadD 216k =
acad -Mamed Plot Skyles 63K
e acad -Named Plat Styles3D 215K
acadiso 63 k_
|oan) acadisazn 216k
oo acadIS0 -Mamed Plat Styles 6k
@acadlso -Mamed Plot Styles3D 215k
@Initial Setup-Architectural-Imp. .. 65k
Initial Setup-Architectural-Metric 65K
Initial Setup-Civil-Imperial 65k
Initial Setup-Civil-Metric 65 k-\s;'l
e i A ¥ L
e | ]
File name: |‘3°‘3‘:|

¥ (e [

Files of type: | Drrawing Template [ dwt]

9 e ]

1.11_OPENING AN EXISTING FILE

This dialogue box will allow you to select the desired template.

AutoCAD template files have the extension *.dwt.

AutoCAD 2010 has lots of premade templates you can use, or you can create
your own template.
For now, we will use acad.dwt for some of our exercises.
Click Open to start a new file.

To open an existing file for further editing, click the Open button from the
Quick Access Toolbar.
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®  The following dialog box will appear:

3 Select File X
Look in: | [ Sample 0%| & @ ¥ B Vews v Toos w
- Freview
Mame = Siz | )
3D House 1,963 K [ :
E Architectural - Annotation Sca... 185k F IW' :
Blocks and Tables - Imperial 222k I T H..' i
E Blocks and Tables - Metric 253k e i R
colorwh 1,746 kim
db_samp 250k
FS Lineweights sa k|
Plot Screening and Fill Patterns a4 k
Tablet 479K =
E TrueType 69k
ﬁ isualization - Aerial 462 k|
an - Condominiurm wi... 1,034 K!
F Visualization - Conference Room 679k
Visualization - Sun and Sky De. .. 327 k;l
L] S l ]
[ Select Initial Yigw
Elerame: |Visualizati0n - Condorminiurm with Skylight ,v| B
Files of type: | Drawing [*dwg) ¥

Specify the hard drive, and the folder your file resides in.
AutoCAD drawing files have the extension *.dwg.
If you want to open a single file, select the file and click open (you can also
double-click on the file’s name).
= If you want to open more than one file, select the first file name, then hold
the [Ctrl] key on the keyboard, and click the other file names.
You can open as many files as you wish.
When you are done, click Open.

Quick View

= Ifyou open more than one file, you can use two functions in the Status Bar:
Quick View Drawings and Quick View Layouts.

Quick View Drawings
Quick View Layout
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If these two buttons are switched on, you will see the following:

‘f%fét |

ME L]
Architectural - Ann... Blocks and Tables ... Blocks and Tables -...

HME x

You will see all of the open files.

In order to jump from one file to another, click the window of the desired file.

When you hover over any of the files, you will see the layouts of the file, and
the picture will change to:

Mogel 150 AL
- -

T |

EEEENIEES

Also, you will see a small toolbar at the bottom of the screen that will enable
you to:

¢ Close the Quick View

e Openafile

e Start a new file

e Pin Quick View Drawings

If you right-click the Quick View button of any file, the following menu will
appear:

Windows b
Copy File as a Link
Close All

Close Other Files
Save all

Close Blocks and Tables - Imperial
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*  You can close all files

* Close other files except the current file
e Save all files

¢ (Close the current file

Organizing Files

®  Make sure you are in the View tab on the Ribbon. There are several ways
to organize the files by using the Windows panel.

Tile Horizontally

ﬁ Tile Vertically

r‘Dh = Tile Horé- Iy =% Drawing Status Bar
e =]
Sitch [l[l Tile Verbically b 8 Window Locking ~

5
Windows = % Cascade Bar - E Text Window

/ \ Windows
Switch Drawings J

®  The Switch Drawings button will show you a list of the opened files. The
current file will be listed with a checkmark (¥). If you want another file,
select the name of the desired file.
worw- B The rest of file commands, such as Save, Save As, and Exit, are identical to
those in other Windows applications.

Cascade Files

INTRODUCING AUTOCAD® 2010

w Exercise 1
1. Start AutoCAD 2010.

2. From the Quick Access Toolbar, click the Open button.

3. Goto the Samples folder under the AutoCAD 2010 folder. Open the following
three files:

a. Blocks and Tables—Metric.dwg
b. dbsamp.dwg
c. Architectural and Annotation Scaling—Multileader.dwg

4. Using Quick View Drawings, jump from one file to another. Using
Quick View Layouts, take a look at the layouts in each file.

5. Using one of the open files, use the mouse wheel—like any of the other
methods discussed in this chapter—and zoom in, zoom out, and pan.

6. Using the right-click menu on the Quick View Drawings, close all files
without saving.
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CHAPTER REVIEW

1.

You can close all open files using one command:
a. True

b. False

CAD stands for

In AutoCAD there are two available spaces: Model Space and Paper
Space. Which of the following statements is true?

a. You draw on Model Space and print from Paper Space.
b. You draw in Paper Space and print from Model Space.
c. There is only one space in AutoCAD.

d. Model Space is only for 3D design.

Positive angles start from the north.

a. True

b. False

AutoCAD is one of the few software applications that allows users to:
a. Connect to the Internet.

b. Type commands using the keyboard.

c. Accept Cartesian coordinates.

d. Create positive angles that are CCW.

is a tool in AutoCAD that allows users to see all open
files in small windows.

CHAPTER REVIEW ANSWERS

1
2
3.
4.
5
6

a
Computer Aided Design/Drafting
a
b
b

Quick View Drawings
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In This Chapter

Introduction

The Line Command

Drafting Using Dynamic Input

Precision Method 1: Snap and Grid
Precision Method 2: Direct Distance Entry and Ortho
The Arc Command

The Circle Command

Precision Method 3: Object Snap (OSNAP)
Object Snap Tracking (OTRACK)

The Pline Command

Polar Tracking

The Erase Command

Oops, Undo, and Redo Commands
Redraw and Regen Commands

O CRC R C R LR RC R R R R R R

2.1 INTRODUCTION

®  The two most important things in drafting are:
e Precision
* Speed

®  You always want to finish your drawing as fast as possible, yet you do not
want to undermine your drawing’s precision.

®  Ttis best to learn precision before speed because it is easier to learn to speed
up the creation process than it is to improve accuracy.

= In this chapter we will tackle many commands, but learning to draft with
precision is most important.
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2.2 THE LINE COMMAND

NOTE

The Line command is used to draw segments of straight lines.
There are many methods available to draw precise shapes using the Line
command (which we will learn later). For now, we will type coordinates in
the Command Window.

= On the Ribbon, make sure you are in the Home tab. Using the Draw panel,
click the Line button.

f"
ASE
Ly Q,)”

Line

Draw »

Creates straight line segments

[t LINE

Press F1 for more help

®  The following prompts will appear:

Specify first point: (type in the coordinate of
the first point)

Specify next point or [Undo]: (type in the
coordinate of the second point)

Specify next point or [Undo]: (type in the
coordinate of the third point)

Specify next point or [Close/Undol: (type in the
coordinate of the fourth point)

®  You can use the Undo option at any time to undo the last specified point,
hence the last specified segment.

®  After you draw two segments, the Close option will be available to connect
the last point to the first point and to end the command.

®  Other ways of ending the command include pressing [Enter] or
[Spacebar].
You can also press [Esc] to end the Line command.
If you are using the Line command and you right-click, you will get the
following menu (which is identical to the command prompt):
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Enter
Cancel

Recent Input »

Close
Undo

Snap Cverrides L

5] Pan
Q Zoom

@ Steering'wheels

QuickiZalz

2.3 DRAFTING USING DYNAMIC INPUT

By default, the Dynamic Input is turned on, so anything you type in the
Command Window will appear on the screen beside the AutoCAD®
Cursor.

Make sure the Dynamic Input button is turned on:

EEEL

leflfw]+8]

| Dynamic Input ‘

For example, if you type the word “line,” here is how it will look on the

screen:
line:

When you press [Enter], the following will appear:

Specify firsk point: SROLL | 92508

Type the X coordinates, then press the [Tab] key and you will see the

following:
|5pecify firsk poink: || 3 EI| . 5135]
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= Type the Y coordinates, then press [Enter] and Dynamic Input will show
the length and the angle of the line to be drawn (the angle is measured from
the east and incremented by 1 degree).

A

| | Specify next paint or |

362

e o

®  Specify the length, press the [Tab] key, then type the angle and press
[Enter]:

L

‘ | Specify next point or @|

DRAWING LINES: FIRST METHOD

w Exercise 2
1. Start AutoCAD 2010.

2. Open the file Exercise_02.dwg.
3. Make sure that Polar Input is off and Dynamic Input is on.
4. Draw the following lines using the Line command and Dynamic Input:

5.0 -‘

5. Save the file and close it.
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S -

Start the Line command and then type the coordinates of the first point.
While Dynamic Input is on, specify the length of the line, press [Tab], and
then specify the angle. Do the same for the other line segments.

2.4 PRECISION METHOD 1: SNAP AND GRID

As you can see, the only method we used to precisely specify points in the
X,Y plane was to type the coordinates using Dynamic Input.

We do this because we cannot depend on the mouse to specify precise
points.

In order to use the mouse precisely, we have to use tools to control its
movement.

Snap is the only tool in AutoCAD that can help us control the movement of
the mouse.

Using the Status Bar, click on the Snap Mode button.

Snap Mode

Now, move to the Graphical Area and watch the mouse jump to exact
points.

The Grid will show a grid of points on the screen similar to grid paper, which
is used in drawing diagrams (these points are not real points).

A Grid on its own is not accurate, but it is a helpful tool to use with Snap.
On the Status Bar, click on the Grid button.

E=3]0]

LaElb o Olefle = [+]a]

Grid Display

You can now see the points displayed on the screen.

If you think the default values for either Snap or Grid do not satisfy your
needs, simply right-click one of the two buttons and the following shortcut
menu will appear:

v Enabled
v Use Icans

Sektings...

Display b
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| ]
oy H

®  Select Settings and the following dialog box will appear:

X Drafting Settings

Snap and Grid !.F'-o_lér.T-raE:.k-i.ng Db|ec:t8nap | if).ynami.c:ulhpu-t

Snap On [F9)
Snap spacing
[o.5000

E_D.SDDD

Equal and ' zpacing

Shap ¥ spacing:

Snap Y spacing:

Folar zpacing

Snap type

&) Grid shap
(&) Rectangular snap

O lzometric shap

O PolarSnap

Grid On [F7)
Grid zpacing
Grid ¥ spacing: (05000
Grid ' spacing: @
M ajor line eveny: i-5 e
Grid behavior

Adaptive grid
[ Allows subdivision belaw grid
zpacing
[ Dizplay grid beyond Limits
[ Follow Dynamic UCS

[

OF. ” Cancel H Help

]

® By default, Snap X spacing and Snap Y spacing are equal; Grid X spacing
and Grid Y spacing are also equal. If you want this to continue, make sure
that the checkbox Equal X and Y spacing is always checked.

® By default, if you are working with 2D you will only see Grid dots. If you
work with 3D, you will see Grid lines; therefore, you must set the Major

line spacing.

Also, all of the settings of Grid behavior are meant for 3D drawings.
Make sure that Snap type is Grid snap (we will discuss Polar Snap
shortly). If you are creating a 2D drawing, then select the Rectangular snap
option. If you are creating a 3D drawing, select Isometric snap.

e F9 = Snap on/off
e F7 = Grid on/off

SNAP AND GRID

If you want Grid to follow Snap, set the two grid values to zero.
You can use function keys to turn on both Snap and Grid:

e
d@%

Exercise 3
1. Start AutoCAD 2010.

2. Open the file Exercise_03.dwg.
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3. Using Snap and Grid, draw the following lines without typing any
coordinates on the keyboard. Start from the lower left-hand corner with
2.75,2.25 (do not draw the dimensions):

»‘ 0.75 |

4. Save the file and close it.

®  Change the Snap X spacing to 0.25 first and set the grid values to 0. Switch
both Snap and Grid on and draw the lines as required.

2.5 PRECISION METHOD 2: DIRECT DISTANCE
ENTRY AND ORTHO

" Because we know that lines in AutoCAD are vectors, we need to specify a
length and an angle to successfully draw them.

®  Ortho is a tool that will force the cursor to always give us orthogonal angles
(i.e., 0, 90, 180, and 270).

= Direct Distance Entry is a very handy tool in drafting; if the mouse
is already directed toward an angle, just type in the distance and press
[Enter].

= Combining the two tools will allow us to draw lines with precise lengths and
angles.

= Follow these steps:
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On the Status Bar, click the Ortho Mode button.

&

Dzl [+]a]

Ortho Mode |

Start the Line command.

Specify the first point.

Move the mouse to the right, up, left, and down. Notice how it only gives
you orthogonal angles.

Use the desired angle, type in the distance, and press [Enter].
Continue with other segments using the same method.

o= B You can also use Direct Distance Entry with Dynamic Input.

DIRECT DISTANCE ENTRY AND ORTHO

w Exercise 4
1. Start AutoCAD 2010.
2. Open file Exercise_04.dwg.

3. Using Ortho and Direct Distance Entry, draw the shape that follows
starting from the lower left-hand corner with 3,2 (without dimensions):

»‘ 0.75 |

4. Save the file and close it.



2.6 The Arc Command 27

2.6 THE ARC COMMAND

The Are command is used to draw circular arcs (the arc part of a circle).
Take a look at the following illustration:

Direction — Start

(Tangent)

Second
—Length ul
\ Chard
\\\ Included
End T N\ Angle
"\K \\
o
Radius x‘“x

Center

The information that AutoCAD recognizes about an arc includes:
e Start point
e Second point (not necessarily the midpoint)

e Endpoint
¢ Center point
o Radius

e Length of chord

e Included angle (angle between Start, Center, End)

e Direction (the tangent passes through the start point)

AutoCAD only needs three pieces of information to draw an arc, but not
just any three.

AutoCAD will start asking you to make your first input, choosing either the
start point or the center point, and based on that choice it will ask you to
specify the second piece of information, and so on.
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®  Make sure you are in the Home tab on the Ribbon, and, using the Draw
panel, click the Are button (the small arrow at the right). You will see the
following:

Bl-l L. (8O
f& 3-Point
/J Start, Cenfter, End
£ @

//-ﬂ Start, Center, Angle
+ o

ﬂ Start, Center, Length
+ o

,//—n Start, End, Angle

!

[/-“ Start, End, Direction
2

/-[ Start, End, Radius

!
'/ﬂ Canter, Start, End
iy

#7 Canfter, Start, Angle

ﬂ)—n Continue

®  Before you start, specify the desired method from the menu and AutoCAD

will take it from there.
o B Always think counterclockwise (CCW) when specifying points.

DRAWING ARCS

w Exercise 5
1. Start AutoCAD 2010.
2. Open the file Exericise_05.dwg. You will see the following shape:
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Py g
f

g

3. Turn on Snap and Grid.

4. Draw the first arc between point (1) and (2) using Start, End, Angle, where
point (1) is the start point and the angle = —90.

5. Draw the second arc between point (3) and (4) using Start, End, Direction,
where point (3) is the start point and the direction = 270.

6. Draw the third arc between point (5) and (6) using Start, Center, End,
where point (6) is the start point and the point at the lower left is the center
point (you can specify it using Snap and Grid).

7. Draw the fourth arc between point (7) and (8) using Start, Center, Length,
where point (8) is the start point, the point at the lower right is the center
point, and the length of the chord is the distance between (8) and (7).

8. The shape should look like this:

9. Save the file and close it.
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2.7 THE CIRCLE COMMAND

The Circle command is used to draw a circle.

There are six different methods available to draw a circle in AutoCAD.

To use the first two methods you have to know the center of the circle. They
are:

Center / Radius Center / Diametes

®  To use the third method, select three points opposite each other (see the
following illustration) on the perimeter of the circle.

®  To use the fourth method, specify two points opposite each other on the
perimeter of the circle. The distance between them is equal to the diameter.

/ o o 3
L 5 \ { \
|

2 Paints 3 Points

®  To use the fifth method, you should have two objects already drawn—we
can consider them as tangents—then specify a radius.

" To use the sixth method, you should specify three tangents by selecting
three objects.

A ’ A ; 4 )\x
\ ;| S A . S8
X ‘// : B f
Tangent/Ta ngé;han gent Tangent/Tangent/Radius

®  Make sure you are in the Home tab on the Ribbon, and, using the Draw
panel, click the Circle button (the small arrow at the right). You will see
the following:



Drawing a Circle

Line

®  Before you start, specify the desired method from the menu and AutoCAD

will take it from there.

DRAWING A CIRCLE

@ Tan, Tan, Radius
O Tan, Tan, Tan

Exercise 6
1. Start AutoCAD 2010.

M
owo

2. Open the file Exericise_06.dwg.
3. Make sure that Snap and Grid are on.
4. Draw the five circles, which should look like the following:

R0.25—_ R 0325
\
\ /
\A)
)) \\
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\\\ I ‘-J\ //,/ \x-‘-\-"'\-‘
X, ~— lani/lanflar
nos 7 \D 05

5. Save the file and close it.
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2.8 PRECISION METHOD 3: OBJECT SNAP (OSNAP)

AutoCAD keeps a full record of each object in each drawing.
Object Snap (OSNAP) is a tool that helps you utilize these records when
you need to specify points on objects already precisely drawn without
knowing the points.

= For example,
* Assume we have the following shape:

=N

\

4
'\\_ﬂ,,)

e We have no information about any object in this shape.

*  We were asked to draw a precise line from the midpoint of the right line
to the tangent to the top of the circle.

e The command to draw is Line. AutoCAD asked us to specify the first
point and we typed mid and pressed [Enter] (or [Spacebar]), then
went directly to the upper line and a yellow triangle appeared. We
clicked:

Specify First poink: of

‘ Midpoint

e AutoCAD then asked us to specify the next point. We typed tan and pressed
[Enter] (or [Spacebar]), then went directly to the top of the circle and a
yellow circle appeared. We clicked it and then pressed [Enter] to end the
command:
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Tangent
Specify next point ar to

e Mission accomplished.

()~

%

= Some of the OSNAPs are used to catch the following:
* The endpoint of an object
* The midpoint of an object
e The intersection of two objects
e The center of an arc or a circle
* The quadrant of an arc or a circle
* The tangent of an arc or a circle
e The perpendicular point on an object
* A point on an object nearest to your click point
Torwp- B We will discuss more OSNAPs as we learn additional commands.
There are three ways to use the OSNAPs whenever you are asked to specify
a point, these include: Typing, [Shift] + right-click, Running OSNAP.

Typing

®  Type the first three letters of the desired OSNAP such as, end, mid, cen,
qua, int, per, tan, and nea. This is a very old method, but often used among
seasoned users of AutoCAD.
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[Shift] + Right-click

= Hold the [Shift] key and right-click. The following menu will appear. Select
the desired OSNAP.

= Temporary track point
i From
Mid Between 2 Points

Point: Filkers

;( Intersection
\\ Apparent Intersect
—- Extension
O Center
<% quadrant
JD Tangenk
_L perpendicular
// Parallel

' Node
5 Insert
b Neapsst

I_m. [one

nu Qsnap Setkings. ..

Running OSNAP

This method is the most practical method of those we have mentioned.
You will select an OSNAP and it will run all the time. The next time you are
asked to specify an endpoint, for example, simply go to the desired point and
it will be acquired immediately.
®  There are two ways to activate running OSNAP:
* On the Status Bar, right-click the OSNAP button and the following
menu will appear:
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' Endpoint

Midpoint
Center

2 Mode
{.3' Quadrant

" B
Intersection

IEI Extension

& Insertion

_L_ Perpendicular

O Tangent

/'“S Mearest

\0\ Apparent Intersection

£ Parallel

v Enabled
v Lse Icons

Settings...
Display

AE

e In this example, Endpoint, Midpoint, Center, Intersection, and

Extension, are all running (each icon has a frame around it).
*  You can also select Settings and the following dialog box will appear:

[ Drafting Settings

[ Snap and Grid [ Polar Tracking|

Object Snap On [F3]
Object Snap modes

O Endpaint
Midpoint
Center
[ Hode

] Quadrant

X ¢ B O >

Interzection
. Extenzion

| Dynamic Input | Quick Properties|

Object Snap Tracking On [F11)

[ Insertion Select &l

[ Perpendicular
[ Tangent

[ Mearest

[ &pparent intersection

[ Paraliel

fi To track from an Dznap point, pause over the point while in a
g command. A tracking vector appears when pou move the cursor,
To stop tracking, pause over the point again.

OF. ” Cancel H Help

Switch on the desired OSNAP and click OK.
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2.9 OBJECT SNAP TRACKING (OTRACK)

= If you have a rectangle, and you want to draw a circle where its center will
coincide with the exact center of the rectangle, Object Snap Tracking
(OTRACK) will help you do this without drawing any new objects to
facilitate specifying the exact points.

®  OTRACK uses OSNAP:s of existing objects to steal the coordinates of the
new point.

= On the Status Bar, click the OTRACK button.

la@EL |=|0«l]+]+]a

ﬁ%bﬁc—d Snap Tracking |

®  Make sure that OSNAP is also on, as OTRACK alone would not do
anything.

Example of Two-points OTRACK

®  Let’s look at an example where we will use two points to specify one point.
e Assume we have the following rectangle:

e Make sure that OSNAP and OTRACK are both turned on. Make sure
that Midpoint in OSNAP is also turned on.

e Start the Circle command, which will ask you to specify the center
point.

* Go to the upper (or lower) horizontal line and move to the midpoint
and hover for a couple of seconds, then move up or down. You will see
an infinite line extending in both directions (do not click), just like the
following:
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—
| Midpoink: 0.98858 < 270°
: Specify center point For circle or

* Go to the right (or left) vertical line and move to the midpoint and hover

for couple of seconds, then move right or left. You will see an infinite line
extending in both directions, just like the following:

T Midpoinks 09790 < 180%
Specify center paint For circle ar &l

e Now, move your cursor to where you think the two infinite lines should

intersect:

Midpoint: = 270°, Midpoint: < 180°
Specifv center point For circle or
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Once you see the two infinite lines, click. You have specified the center
point of the circle. You can now type in the radius (diameter) of the
circle:

Example of One-point OTRACK

®  Let’s look at another example. This time we will use one point to specify

one point:

e Continue with the same rectangle used in the last example.

e Start the Circle command, which will ask you to specify the center point.

e Make sure both OSNAP and OTRACK are turned on, and also turn on
Center in OSNAP.

* Go to the center point of the existing circle, and hover for couple of

seconds, then move to the right. An infinite line will appear:

Center) 1,1052 <07 9
Specify center point for circle or 2]

e Type 2 (or any distance) and press [Enter]:

|

.........
Center: 1,.2535 < 0° 2| 7.5352

Specify center point For circle or -
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e The center of the new circle will be specified, then type in the radius.
You will see the following:

Jorwe B If you hover over a point for couple of seconds to produce the infinite line
and then discover that it is not the desired point, simply go to the same point
again, and hover over it for a couple of seconds to disable it.

DRAWING USING OSNAP AND OTRACK

‘i;é% Exercise 7
1. Start AutoCAD 2010.

2. Open the file Exercise_07.dwg.

3

e

i

k" 5

3. Make sure that Snap and Grid are both turned off.

Using OSNAP, switch on Endpoint.

5. Draw the first arc between points (1) and (2) using Start, End, Angle, where
point (1) is the start point and the angle = —90.

6. Draw the second arc between points (3) and (4) using Start, End, Direction,
where point (3) is the start point and the direction = 270.

=
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7. Draw the third arc between points (5) and (6) using Start, Center, End,
where point (6) is the start point. To specify the center point, use OTRACK
between points (5) and (6).

8. Draw the fourth arc between points (7) and (8) using Start, Center,
Length, where point (8) is the start point. To specify the center point, use
OTRACK between points (7) and (8), where the length of the chord is the
distance between (8) and (7).

9. The shape should look like the following:

10. Using OSNAP, turn Intersection on. Use Intersection to specify the
center points for the five small circles. (By default, AutoCAD will activate
Tangent when you use the Tan, Tan, Tan method.)
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11. Save the file and close it.
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DRAWING USING OSNAP AND OTRACK

w Exercise 8

Start AutoCAD 2010.

Open the file Exercise_08.dwg.

Turn OSNAP on and set the following: Endpoint, Midpoint, and Center.
Turn on OTRACK.

Draw the four circles and specify the center using OSNAP and OTRACK.

GUk L o=

R050 —/ S RO0.22

6. Save the file and close it.

2,10 THE PLINE COMMAND

= Pline means “polyline” and poly means many—so, if you exchange many with
poly, the new name would be “many lines.”
®  To begin, let’s compare the Line command and the Pline command.

Line Pline
Each segment is an object One object with vertices
Lines only Lines and arcs
No width Variable width for start and finish

[ o |
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®  As you can see from the comparison, there are mainly three differences
between the two commands.

®  Make sure you are in the Home tab on the Ribbon, and, using the Draw
panel, click the Polyline button:

Polyline

Creates a 20 polyline

[l PLINE

Press F1 for more help

®  The following prompt will appear:

Specify start point:

Current line-width is 0.9000

Specify next point or [Arc/Halfwidth/Length/Undo/Width] :

®  After you specify the first point, the Pline command will give you the current
polyline width (in our example it is 0.90), then it will ask you to specify the next
point. You can use all of the methods we learned in the Line command.

= If you do not want to specify the second point, you can choose from the
following: Arc, Halfwidth, Length, and Width.

Arc

By default, the Pline command will draw lines.
®  You can change the mode to draw arcs by selecting the Are option. The
following prompt will appear:

Specify endpoint of arc or
[Angle/Center/Close/Direction/Halfwidth/Line/Radius/Second pt/
Undo/Width] :

®  We learned in the Are command that AutoCAD needs three pieces of
information to draw an arc.

" AutoCAD already knows the start point of the arc, which is the start point
of the polyline or the endpoint of the last line segment.

®  AutoCAD will assume that the direction of the arc will be the same
angle as the last line segment. Users have the right to accept or reject this
assumption.

® If you accept this assumption, then AutoCAD will ask you to specify the
endpoint of the arc.

= Ifyou reject this assumption, then you will need to specify the second piece
of information from the following:
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* Angle of arc, then center or radius
e Center, then angle or length

e Direction, then end

* Radius, then end or angle

¢ Second, then end

Halfwidth

®  The first method is to specify the width of the polyline.
®  Specify the halfwidth of the polyline from the center to one of its edges,
something like the following:

Halfwidtr

_________ 3

= When you select this option, AutoCAD will give you the following prompt:

Specify starting half-width <1.0000>:
Specify ending half-width <1.0000>:

®  In this example, the halfwidth was 1.0 for both the start point and endpoint.

Length

®  In the Pline command, if you draw an arc, then switch to the Line command
to draw a line segment, and if you want the line to be tangent to the arc,
then select this option.

®  This option will assume the angle to be the same of the last segment, hence,
you will only be asked for the length. The following prompt will appear:

Specify length of line:

Width

= Width is the same as halfwidth, but instead, you have to input the full width.
See the following illustration:
— Width
i
1

7orw 8 The Undo and Close options are the same options as in the Line
command.
®  If you choose to close in the Are option, it will close the shape by an arc.
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DRAWING POLYLINES

w Exercise 9
1. Start AutoCAD 2010.
2. Open the file Exercise_09.dwg.

3. Using Ortho and Direct Distance Entry, draw the following shape
(without dimensions) using the Pline command with width = 0.1.

4. Save the file and close it.
@ ®  Take note of the following tips:

e In order to draw the large arc, use angle = 180.
* Before you draw the last arc, change the mode to Are and select
Close.

2.11 POLAR TRACKING

®  We learned that we can force the cursor to give us four orthogonal angles
(0, 90, 180, 270) using ORTHO.

= If we want other angles, such as 30 and its multiples or 60 and its multiples,
ORTHO would not help us. For this reason, AutoCAD provides another
powerful tool called Polar Tracking.

®  Polar Tracking allows you to have rays starting from your current point
pointing toward angles such as 30, 60, 90, 120, and so on. You can use Direct
Distance Entry just as we did with ORTHO.

®  On the Status Bar, click the Polar Tracking button.

Lol o Ol flej=[+]a]

| Polar Tracking |
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= In order to select the desired angle, right click on the button and you will
see the following menu:

)

v 45
30
22,5
15
15
10
5

| v Enabled
| w Use Icons

Settings...
Display »

®  Select the desired angle and you will get it, along with its multiples.
= Ifyou want more control, right-click on the button and select Settings. The
following dialog box will appear:

3 Drafting Settings

Palar Tracking On [F10)
Folar Angle Settings Object Snap Tracking Settings
Increment angle: (&) Track orthogonally only
|_45 b (O Track uzing all polar angle settings
[ Additional angles
Mew
e Palar Angle measurement
) Shzolute
() Relative to last segment
|

Increment Angle

= Under Polar Angle Settings, select the Increment angle (a list in a
drop-down menu where you will find predefined angles). Select the desired
angle.
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i o

If the desired angle is not on the list, simply type your own angle.
Based on this example, users will have rays in angles 0, 30, 60, 90, 120, etc.

Additional Angles

®  Sometimes, in the design process, you will need some odd angles that the
Increment angle option cannot give you, such as 95 or 115.
=  The Additional angles option will help you set these odd angles.
®  Using the same dialog box, check the Additional angles box.
®  (Click the New button and type in the angle.
®  To delete an existing additional angle, select it and click the Delete
button.
®  You will have something similar to the following:
Polar &ngle Settings
Increment angle:
[45 v
Additional angles
95 MNew
= AutoCAD will not give the multiples of the additional angles.
Polar Snap
®  We previously discussed the SNAP command, which helped us to specify
exact points on the X,Y plane using the mouse.
®  The SNAP command can only help us along the X-axis (+ and —), and along
the Y-axis (+ and —).
= If you want to snap to a point along a ray produced by Polar Snap, you have
to change the type of the SNAP from Grid Snap to Polar Snap.
n

On the Status Bar, switch on SNAP. Right-click on the SNAP button and
select Settings. Under Snap type, select Polar Snap instead of Grid Snap,
just like the following:



2.11 Polar Tracking 47

Snap type
(O Grid snap

() PolaiSnap
= Now, set the Polar spacing value, just like the following:

Polar zpacing

Palar distance: | 1.00 |

Example

®  We want to draw the following shape:

AN . A
D P N
e 3
// "o,
8.0 v 4 o I e .
i
L

®  Let’s assume we set the Increment angle to 45 and we changed the type
of Snap to Polar Snap with a distance = 1.0. The following steps show you
how to draft using Polar Tracking:
 Start the Line command, then specify a starting point.
* Move to the right until you see the ray. Read the distance and the angle.
When you reach your distance, click to specify a point just like the
following:

| e . e . e s
Palar: 60000 < 0
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* Move the cursor toward the angle 45 until you see the ray. Then, move
the mouse to the desired distance and click:

e Palar: 4,0000 < 45

; o 45~_=

* Move the cursor toward the angle 315 until you see the ray. Then, move
the mouse to the desired distance and click:

DRAWING USING POLAR TRACKING

w Exercise 10
1. Start AutoCAD 2010.

2. Open the file Exercise_10.dwg.

3. Switch both Polar Tracking and Polar Snap on and set the following:
a. Increment angle = 30
b. Additional angles = 135
c. Polar distance = 0.5

4. Draw the following shape (without dimensions) starting from 3,2:
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5. Save the file and close it.

212 THE ERASE COMMAND

The Erase command will be the first modifying command we discuss.
The only purpose of this command is to delete any object you select.
Make sure you are in the Home tab on the Ribbon, and, using the Modify

panel, click the Erase button.

L, BOR®-

v EEM -

Mave ﬂﬁ’ﬂ EE ﬂ'
=

Erase
Removes objects from a drawing

MDdifV -

[t ERASE

Press F1 for more help

®  The following prompt will appear:
Select objects:

®  Once this prompt appears the cursor will change to a pick box:
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= Basically, you can do three things with the pick box:
e Touch an object and click to select it.
* Go to an empty place, click, and go to the right; this will get you a

Window.
* Go to an empty place, click, and go to the left; this will get you a
Crossing.
Window

= A window is a rectangle specified by two opposite corners (points). The
first point will be placed when you click on the empty place. Then, release
your hand, go to a suitable place, and click the second point to create the
opposite corner.

First point

=

H]

Second Point

®  Whatever is fully inside the rectangle will be selected. If any part (even a
small part) is outside the rectangle it will not be selected. See the following
illustration:
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Crossing

® A crossing is just like a window, except that whatever is inside it will be
selected in addition to whatever it touches.

First Point

£

Second Point

®  The result will be:

wrw ® These three methods can be used with almost all of the modifying commands,
not just the Erase command.
®  The Select Objects prompt is repetitive. You need to always finish by
pressing [Enter] or you can right-click and use the menu.
®  Other ways to erase objects are:

e Without issuing any command, click on the desired object(s) and press
the [Del] key.
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e Without issuing any command, click on the desired object(s), then right-
click, and the following shortcut menu will appear. Select Erase.

Repeak ERASE
Recent Input L4
3

S Chrl+¥
|T_"‘| Copy Chrl+C
rI'ZL_ Copy with Base Point CErl+3hift+C
[T Paste Chrl+y
_é_; Erase
+§+ [ove
Oc;; Copy Selection
E Scale
{:J Ratate

Draw Order L4

I[} Deselect all

Action Recorder L4
Subobject Selection Filker L
[ ouick select...
QuickCale
@ Find. ..,

Froperties
Cuick Properties

2,13 OOPS, UNDO, AND REDO COMMANDS

®  This group of commands can help you correct your mistakes.
®  They can be used in the current session only (i.e., once you close the file,
they will be useless).

Oops

Oops is used to retain the last group of erased objects.

Oops only works with the Erase command.

This command is only available in the Command Window.

You have to type the full command in the Command Window: Oops.

No prompt will be displayed, but you will see the last group of erased objects
returned to the drawing.
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Undo

Undo is used to undo the last command.
You can reach this command using one of the following methods:
e From the Quick Access toolbar, click the Undo button:

e Type u in the Command Window (don'’t type undo, because it has a
different meaning).

e Press [Ctrl] + Z.

The last command will be undone.

You can undo as many commands as you want in the current session.

Redo

This command is used to undo the undo.
You can use this command using one of the following methods:
e From the Quick Access toolbar, click the Redo button.

Insert A.Rmte

Pa

e Type redo in the Command Window.

e Orpress [Ctr]] + Y.

The last undone command will be redone.

You can redo as many commands as you want in the current session.

2.14 REDRAW AND REGEN COMMANDS

There are times when you need to refresh the screen for one reason or
another.

Sometimes you will need AutoCAD to regenerate the whole drawing to show
the arcs and circles as smooth curves.

Neither command has a toolbar button.
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Redraw

= From the Menu Browser, select View/Redraw or type r in the Command
Window.
®  The screen will be refreshed.

Regen
®  From the Menu Browser, select View/Regen or type re in the Command
Window.

®  See the following example:
e This is how the drawing looks before the Regen command:

* This is how the drawing looks after the Regen command:

¢ Notice the lines are smoother.
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ERASE, OOPS, UNDO, AND REDO

‘?‘;éb“ Exercise 11
1. Start AutoCAD 2010.
2. Open the file Exercise_11.dwg.
3. Using the Erase command with Window or Crossing, perform the
following steps:
a. Using Window, try to erase all of the rectangles in the middle. Press
[Enter], then use the Oops command to retain the objects.

b. Using Crossing, try to erase the circles on the right-hand side of the shape.
Press [Enter] and then Undo. Also, try Redo to see the effect.

c. Using a pick box, try to erase the lines of the frame. Press [Enter] and
then use Undo to undo the erasing.

4. Close the file without saving.

CHAPTER REVIEW

1. Which of the following statements are true:
a. Smap will help us control the mouse whereas Grid is complementary to

Snap.
b. Ortho and Direct Distance Entry will help us draw exact orthogonal
lines.
c. You can use Direct Distance Entry with Dynamic Input, Ortho, and
Polar Tracking.
d. All of the above.
2. The Arc command in AutoCAD will draw a arc.

3. Using OTRACK, you can:
a. Specily a point using two existing points.
b. Specify the radius of an arc.
c. Specify the end of an existing line.
d. None of the above.
4. OTRACK doesn’t need OSNAP to work.
a. True
b. False
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5. In Polar Tracking, if the Increment angle option did not fulfill all your
needs:

a. Ortho will help.
b. Set the additional angles.
c. The command PolarNewAngles will help.
d. None of the above.
6. There are ways to draw a circle in AutoCAD.

CHAPTER REVIEW ANSWERS
d

circular

a
b
b

six

S ULk D=
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Chapter YOUR DRAWING

In This Chapter

Things to Consider before You Set Up Your Drawing
Step 1: Drawing Units

Step 2: Drawing Limits

Step 3: Creating Layers

Layer Functions

Quick Properties, Properties, and Match Properties

SO

3.1 THINGS TO CONSIDER BEFORE
YOU SET UP YOUR DRAWING

®  There are many things you will need to think about when you set up your
drawing file. Of course, we cannot cover them all in this chapter, but we will
cover the most important things.

Drawing Units

®  We will first define the drawing distance and angle units, along with their
precision.

Drawing Limits

" Try to figure out what size (area) workspace will be sufficient to accommodate
your drawing.

Layers

®  Layers are the most effective way to organize your drawings, so we will learn
what they are, how to create them, and how to control them.
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w to Set Up Your Drawing

Jorwe ® In Appendix A, we will discuss ways to create templates in AutoCAD®, which
are more applicable for businesses than individuals.

3.2 STEP 1: DRAWING UNITS

= First, you will learn how to draw units.
®  This command will allow you to select the proper length and angle units.
= From the Application Menu select Drawing/Units:

P

S=)

v L
§ i

Tools to maintain the drawing

Drawing Properties
Sets and displays the file properties of the
current drawing

ESEWE :

Units

i
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&

E,

O
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2
%
i

o
.
it

Controls coordilugte and angle display
Audit

Evaluates the integrity of a drawing and
corrects some errors

Purge

Removes unusad named items, such as
block definitions and layers, from the
drawing

Recover
Repairs & damaged drawing file

Open the Drawing Recovery Mana...
Displays the drawings that may nead to
be recovered after a program ar system
failure

Options Exit AutoCAD
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®  After you make your selection, the following dialog box will appear:

[ Drawing Units
Length Angle
Type: Type:
| Engineering v | | Decimal Degrees . |
Precision: Precision:
| o-0.0000" g [0 ¥
[ Clockwize

Inzertion scale

Units to scale inserted content:
| Inches »
Sample Output

1.5000",.2.0039",0.0000"
3.0000"<45.0.0000"

Lighting

Units for specifying the intensity of lighting:

|_Intemati0na| »
| oK H[ Cancel ][ Directior... ][ Help ]

®  Under Length, set the desired Type. You will have five choices:
e Architectural (example: 1'-5 3/16")
* Decimal (example: 20.4708)
e Engineering (example: 1'-4.9877")
e Fractional (example: 17 1/16)
* Scientific (example: 1.6531E+01)
®  Under Angle, set the desired Type. You will have five choices:
* Decimal Degrees (example: 45.5)
e Deg/Min/Sec (example: 45d30'30")
e Grads (example: 50.6g)
e Radians (example: 0.8r)
* Surveyor’s Units (example: N 45d30'30" E)
= For the desired Length and Angle, select the Precision, for example:
* Architectural precision can be 0'-0 1/16", 0'-0 1/32", etc.
e Decimal precision can be 0.00, 0.000, etc.
e Deg/Min/Sec precision can be 0d00'00", 0d00'00.0", etc.
® By default, AutoCAD deals with the positive angles counterclockwise. If you
prefer it the other way around, check the clockwise box.
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Under Insertion scale, specify Units to scale inserted content, which
is your drawing’s scale against the scale of any object (a block, for example).
This will help AutoCAD make the suitable conversion.

Click the Direction button to see the following dialog box:

.3 Direction Control

Basze Angle
(® East 0.00
() Narth 50.00
() et 180.00
) South 270.00
O Other Fick / Type
I : e

As we discussed in Chapter 1, AutoCAD always starts the zero angle
measuring from the east. If you want to change the direction, select the
desired angle to be considered as the new zero.

3.3 STEP 2: DRAWING LIMITS

= In Chapter 1, we learned that AutoCAD offers an unlimited drawing sheet,
which extends in all directions. We will not use it all, instead we will specify
an area that gives us our limits.

®  Drawing Limits is the workspace you select to work in and can be specified
using two points: the lower left-hand corner and the upper right-hand
corner.

= Since we will draw in Model Space and print from Paper Space, we do
not need to think about drawing scale at this point.

®  To know the exact limits needed, make sure you have the following
information:
e What is the longest dimension in your sketch in both the X-axis and Y-axis?
* What AutoCAD unit have you selected (e.g., meter, centimeter,

millimeter, inch, foot, etc.)?

= Accordingly, you will know the limit of your drawing.

Example

®  Assume we have the following case:

*  We want to draw an architectural plan, which extends in X for 50 m and
in Y for 30 m.
¢ Also, assume that one AutoCAD unit = 1 m.
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If one AutoCAD unit = 1 m, then 50 m is equal to 50 AutoCAD units, which
also applies to 30 m.

Note that 0,0 is always the common lower left-hand corner, so there is no
need to change it. The upper right-hand corner will be 50,30.

At the command prompt, type limits, the following prompt will appear in
the Command Window:

Specify lower left corner or [ON/OFF] <0,0>: (press [Enter]
to accept the default value)Specify upper right corner
<12,9>: (type in the coordinate of the upper right corner)

i 2

To keep yourself from using any area outside this limit, turn on the
Limits.

DRAWING UNITS AND LIMITS

e
owc\

Exercise 12

1.
2.
3.

*®

Start AutoCAD 2010.
Open the file Exercise_12.dwg.

Note the current units (look at the lower left-hand corner of the screen and
you will see the coordinates of the drawing).

From the Application Menu select Drawing/Units. Change the units to be:
a. Length Type = Architectural

b. Length Precision = 0'-0 1/32"

c. Angle Type = Deg/Min/Sec

d. Angle Precision = 0d00'00"

Now, check the coordinates again and see how the numbers have changed
with the new units.

Using the Limits command, do the following:

a. Accept the default point for the lower left-hand corner.
b. For the upper right-hand corner type 30',20'.

Switch Grid on and double-click on the mouse wheel.

You will see your current settings.

Save and close the file.
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3.4 STEP 3: CREATING LAYERS

oty

What Are Layers?

Let’s assume that we have a large number of transparent papers along with
256 colored pens.

Taking care that we do not draw anywhere except on the top of the paper,
we select the red pen and draw the border of the drawing.

Then, we move the second paper to the top, and we draw an architectural
wall plan using the yellow pen.

Next, we move the third paper to the top and we draw the doors using the
green pen. Employing the same procedure we draw windows, furniture,
electrical outlets, hatching, text, dimensioning, etc.

Then, we take all of the papers and look at them at the same time. What do
we see? A full architectural plan!

In AutoCAD we call each paper a layer.

Each layer should have a name, color, linetype, lineweight, and much more
information.

There will be a layer, which will be in all of AutoCAD’s drawings. This layer
is 0 (zero). You cannot delete it or rename it.

In order to draw on a layer, you must first make it current. Only one layer
will be current at a time.

The objects drawn on a layer will automatically inherit the properties (color,
linetype, lineweight, etc.) of the current layer. Hence, a line in the red layer, with
a dashdot linetype and 0.3 lineweight will have the exact same properties.

By default, the setting of the object’s color is = BYLAYER.

By default, the setting of the object’s linetype is = BYLAYER.

By default, the setting of the object’s lineweight is = BYLAYER.

It is highly recommended to keep these settings intact, as changing them
may lead to creating objects with nonstandard properties.

On the Ribbon, make sure you are in the Home tab. Using the Layers
panel, click the Layer Properties button.

AR

Lt aved Layer State b

Layers w

‘| Layer Properties

Manages layers and layer properties

[ LAYER

Press F1 for more help

The following dialog box will appear:
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o Current layer: 0 |5earch for layer Q|
g =5 R & e
% Filkers <] 5., Name 4 0On | Freeze | Lock | Color Linetype Lineweight | Plot 5... .| Description
=& al W 0 [ ECII I?I M wh.. Continuo.. — Defa...
% Al Used Layers &5 Appliances D: I?I M gr.. Continuo.. — Defa...
& BDRTXT Eet &= M m.. Continuo.. — Defa...
< BRDTITLE Res @ M red Continuo.. — Defa...
<= Cabinetry o @ M % Continuo.. — Defa...
4 DB - Windows Eel &= M blue Continuo.. — Defa...
<= Deck Bos @ Ml cyan Continuo.. — Defa...
< Defpoints o @ M wh.. Continuo.. —— Defa...
4 Dimensions Ret = M red Continuo.. — Defa...
< Doors o & M 155 Continuo., — Defa...
- 4 Lighting I?I B red Continuo.. — Defa...
5" & Power - & M m.. Continuo.. — Defa...
= <& Schedules o & M wh.. Continuo.. — Defa...
f < Stairs Bos @ 203 Continuo.. — Defa...
2 & Text ﬁ &= M wh.. Continuo.. — Defa...
5 < \Viewports b & M wh.. Continuo.. — Defa...
= = Walls o @ M wh.. Continuo.. —— Defa...
a
iz
% [ tnvert Filker <« ||@) il | >
i
g All: 17 layers displayed of 17 total layers

= The Layer Properties is not a normal dialog box; rather, it is a palette that
can be docked, resized, and hidden.

* Drag the title of the palette to the right, left, top, or bottom of the screen
and you will see the Layer Properties palette change its size and dock
at the place you select.

*  You can hide the entire palette and show only the title bar by clicking the
Auto-hide button as shown in the following. Whenever you want to see
the palette again, simply go back to the title and the palette will appear.

* You can show the Properties menu to control the palette. Click the
Properties button as shown.

EL alluse



64 Chapter 3 How to Set Up Your Drawing

e The following menu will appear:

Mave
Size
Close
v Allow Docking

Anchor Left <
aAnchor Right =

Auto-hide
Transparency. ..

e The most important options available in this menu are Anchor Left and
Anchor Right, which automatically dock the palette at the right or at
the left and will switch on Auto-hide.

* You can resize the palette to be larger or smaller. Move to the lower right-
hand corner of the palette; the cursor will change to the following:

s

* Click and drag to the right to make it larger. Click and drag it to the left
to make it smaller.

Creating a New Layer

®  To create a new layer in the drawing, you must prepare all of the necessary
information for the new layer.
=  (Click the New Layer button.

=
- g =0 % Qf
&« Mlamne O | Erepse | lack | Colar Linetune Lir
() New Layer (Alt+N) =]
Creates a new layer. The list displays a layer named LAYER1, The a—
name is selected so that you can enter a new layer name immediately. | —

The new layer inherits the properties of the currently selected layer in
the layer list {color, on or off state, and so on).

& DB - Windows (:) ﬁ & [ blue Continuo.. —

= AutoCAD will add a new layer with the temporary name Layerl. The
Name field will be highlighted. Type the desired name of the layer
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(you can use up to 255 characters and spaces are allowed). Only use the
following:
e Letters (a, b, c, ..., z); lowercase or uppercase doesn’t matter
e Numbers (0,1,2, ...,9)
e Hyphen (-), underscore (_), and dollar sign ($)

" [tis a common practice to use good layer naming, using a name that gives
an idea about the contents of the layer. For example, a layer that contains
the walls of a building would be named “wall.”

Setting a Color for a Layer

After you create a layer, set its color.
AutoCAD uses 256 colors for the layers (as a matter of fact, there are only
255 if we exclude the color of the Graphical Area).
®  The first seven colors can be called by their names or numbers:
e Red (1)
¢ Yellow (2)
e Green (3)
e Cyan (4)
e Blue (5)
* Magenta (6)
o Black/White (7)
The remaining colors can only be called by their numbers.
You can have the same color for more than one layer.
Select the desired layer under the Color field, and click either the name of
the color or the icon. The following dialog box will appear:

[} Select Color

" Index Color | Tue Calor | ColorBooks |

AutoCAD Color Index [AC]):
I X N A O
1 N O A
[ [T 1T 1] ] OO OO0
T I ] 1]
HE | EEE . | o [
2] ]
N N T O 1|
1 O I 1] ]
I N Y O O T T T
Illlllllllllllllllllllll
'

L Ok, ” Cancel ][ Help ]
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Move to the desired color (or type in the name/number) and then click OK.
You can also set the layer’s color through the pop-up list in the Layers panel

by selecting the color icon in the list:

%2 % B 82 %%

Unsaved Layer State -
()T A [l BROTITLE -
II5 %+ & [ BroTIE |g

Q :O: & [l Cabinetry

Q ¥ & [ DB - Windows
mﬁa%ﬁk |
Q jo: & efpoints

Q i & ] Dimensions =
Q ¥ & [ poors

Q % @ M Ushing

Q 2 & W Pover i
Q o & i Schedules

& o & [l Stairs 5

Setting a Linetype for a Layer

AutoCAD comes with a good number of generic predefined linetypes saved
in a couple of files called acad.lin and acadiso.lin.

You can also buy other linetypes from third parties, which can be found
on the Internet. Just go to any search engine and search for “AutoCAD
linetype.” You will find many linetype files, some free of charge and some

you can buy for few dollars.

Not all linetypes are loaded in the drawing files; you may need to load the

desired linetype first before you can use it.

First, select the desired layer. Under the field Linetype, click the name of
the linetype and the following dialog box will appear:

3 Select Linetype

Loaded linetypes

X

| Linetype Appearance Drescription

Solid line
————————— Drazhed [5x)
_________ Hidden

Continuous
DASHED2
HIDDEM

= i ]|

2

L Ok, J [ Cancel ] [ Load... ] [

Help
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®  Ifyour desired linetype is there, select it. To load another linetype, click the
Load button and the following dialog box will appear:

¥ Load or Reload Linatypes E|
File... | acadizo fin

Avalable Linstypes

Linetwpe Descriptian ]
|ACAD_IS002w100 150 dash _ _ _ _E
|ACAD_ISO0ZWH00 150 dashspace i
ACAD_ISOD4wWA00 150 long-dash dat : 2t
(ACAD_ISD0SwW100 150 long-dash double-dat -
|ACAD_IS008w100 150 urg-tash biple-dut -
WACAD_ISANWA NN ISI Ant
ACAD_ISO0aw100 150 long-dash short-dash vex - ]
{ALAD_ISUUEWILU 15U long-dash double-shortdash
|ACAD_ISD10WA100 150 dashdot . __.__.__ o o
|ACAD 15011100 150 double-dash dot . ’ : o
| : mE >

[ oK ] [ Canccl J [ Help ]

®  Select the desired linetype to be loaded and click OK. Now that the linetype

is loaded, it will appear in the Select Linetype dialog box. Select it and
click OK.

Setting a Lineweight for a Layer

®  Select the desired layer under the field Lineweight. Click either the number
or the shape of the lineweight and the following dialog box will appear:

LY Lineweight RIE

Lineweights:

Default

0.00 nan

005 rom

0.09 rom

013 mm

015 om

018 mm

0.20 mm

— 025 mm

e TT——

[— T =

[

Diiginial.  Diefaull
Maw: 10,20 mm

Lk [ rawea ][ Hen |

®  Select the desired lineweight and click OK.
= Ifyou want to view the lineweight of any layer on the screen, click the Show/
Hide Lineweight on the Status Bar.

Show/Hide Lineweight
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ot ® We prefer to see the lineweight using Plot Style (to be discussed later),
which will affect the hardcopy.

Making a Layer the Current Layer

®  There are three ways to make a particular layer the current layer:
e In the Layer Properties Manager dialog box, double-click on the name
or the status of the desired layer.
e In the Layer Properties Manager dialog box, select the desired layer
and click the Set Current button.

B
b = x &55}
et :
Status Naru'v\s = teet :
= 2 Set Current (Alt+C)

& Appl| Sets the selectad layer as the current layer. Objects that you create
0 :

& soe] 2 drawn on the current layer. (CLAYER system variable)

a -

e —— [} S e - i - v

|

* On the Ribbon, make sure you are in the Home tab, and, using the
Layers panel, you will find a pop-up list for the layers. Select the desired
layer name and it will become the current layer:

%2 4% B8 85 %%

Unsaved Layer State -

§ Lt & [l BROTITLE -

PET Craammp|
"0 % 5 W cabinety

Q o & [ DB - Windows

@ % & Il O=ck

| 3% & WOk |
Q Bolr=l | Dimensions

Q 2 & I ooos

Q o & [ Yshting

Q 2 @ W o A
& o & [l Schedules

G & & [l Stairs =
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LAYER NAMES, COLORS, LINETYPES, AND LINEWEIGHTS

w Exercise 13
1. Start AutoCAD 2010.

2. Open the file Exercise_13.dwg.
3. Create the following layers:

Layer Name | Color Linetype Lineweight
Shaft Magenta | Continuous 0.3
Body Cyan Continuous 0.3
Base Green Continuous 0.3
Centerlines 9 Dashdot2 0.5

4. Make Centerlines the current layer. (Make sure Dynamic Input is
turned off.)

5. Draw a line from 6,7.5 to 6,4.5. Draw another line from 8,6 to 4,6.
6. Save the file and close it.

3.5 LAYER FUNCTIONS

Adding More Layers

®  The easiest way to add more layers is to click on the name of any layer while
you are in the Layer Properties Manager dialog box and then press
[Enter].
Accordingly, you can use the New Layer button.
S ol By default, AutoCAD will always sort the layers according to their names.

Selecting Layers

= All of the following methods will be done in the Layer Properties Manager
dialog box.
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There are several ways to select layers:

To select a single layer, simply click on it.

To select multiple nonconsecutive layers, select the first layer, then hold
the [Ctrl] key and click on the other layers.

To select multiple consecutive layers, select the first layer, then hold the
[Shift] button and click on the last layer you wish to select.

To select multiple layers all at once, click on an empty area and hold the
mouse. Move to the right or left and a rectangle will appear. Cover the
layer that you wish to select and release the mouse.

To select all layers, press [Ctrl] + A.

To unselect a selected layer, hold the [Ctrl] key and click it.

One of the most important advantages in selecting multiple layers is the
ability to then set the color, linetype, or lineweight for group of layers in
one step.

Deleting a Layer

You cannot delete a layer that contains objects, so the first step is to empty
the layer from any objects in it.

Using the Layer Properties Manager dialog box, select the desired layer
(or layers) to be deleted and do one of the following:

e Press the [Del] key on the keyboard.

* Click on the Delete Layer button.

EEXV
Status i = Lok =l Linat !
J Delete Layer (Alt+D}

Deletes selected layers. You can delete only unreferenced layers.
Referenced layers indude layers 0 and DEFPOINTS, layers containing
ohjects (including objects in block definitions), the current layer, and
xref-dependent layers.

5

T I

IR

A L e
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What Happens When You Right-Click?

®  Right-clicking here is done in the Layer Properties Manager dialog
box.
®  If you select any layer and right-click, the following shortcut menu will
appear:
w Show Filker Tree
Show Filkers in Layer List

Set current

Mew Layer

Rename Laver Fz
Delete Laver

Change Description

Mew Laver YP Frozen in All Yiewpaorts
WP Freeze Laver in all Yiewports
WP Thaw Layer in Al Yiewports

Isolate selected lavers

Select &l

Clear all

Select All but Current
Inwvett Selection

Invert Laver Filter
Layer Filters 3

Save Layer Skates, .,
Restare Layver State. ..

®  Through this shortcut menu you can do many of the things we discussed

earlier, such as:

e Set the current layer

e Create a new layer

* Delete a layer

e Select all layers

e (lear the selection

¢ Select “All but Current”

o Invert the selection (make the selected unselected, and vice versa)
®  The first two choices in this shortcut menu are:

e Show Filter Tree (turned on by default)

e Show Filters in Layer List (turned off by default)
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® By turning off the Show Filter Tree, the dialog box will have more space,
just like the following:

:f urrent layer: BRULILE =arch for lave Q
2528 5 85Xy @&
P || status | Mame .l On  Fresze Lok  Color  Linekype  Lineweight Plot 5... | P...| M..| Description
P Anpliances I 8 M o Continn.. nefanlt =2
g RNRTXT ) I & M m. Continin... Nefault s 2R
' RROTITI F ) IF & Mred Continun. Nefault 1 =2 B
g Cahinatry I+ & M9 Continin. Nefalt -~ 2R
& NR - Windnws ¥ I+ & M hlue Confinun.. nNefault s 2 B
& Deck J D’ B H oan Continuo... Default } @ =-'
P Defpoints / Q’ & M wh.. Continuo.. —— Default o i.'g H
& Dimensions / e 2 M red Continuo.. — Default 1 28
F=4 Doors / e 2 M 155 Continuo... Default . BB
= P Lighting 1 & Mred Continuo.. — Default 1 2R
§° F=g Power ) e 2 M m.. Continuo.. — Default =
= & Schedules Q’ & M wh.. Continuo.. —— Default 7 @ 51
f e Stairs § D: a W 203 Continuo... Default @
,E & Text J D: & M wh.. Continuc... —— Default @
- P Viewports é - & M wh.. Continuo.. —— Default @
g & wallz / o & M wh.. Continuo.. —— Default =
o
i || i >
== ]
= @ = &l 17 lavers displaved of 17 total lavers
=

®  Or you can you use the two arrows at the left panel, as in the following:

£& Filters (& Status | Mame < i
ERE=AT 1. 0 |
£ Al Used Layers | Callapses Layer filter tree. |
BDRTHT
v BROTITLE
Fg ahinstre

Changing an Object’s Layer

Each object should exist in a layer.
The fastest way to change the object’s layer is the following:
e Without issuing any command, select the object by clicking it.
e In the Layers toolbar, the object’s layer will be displayed. To change it,
click the layer’s pop-up list and select the new layer.
e Press the [Esc] key one time.
o m Other methods to change an object’s layer will be discussed later.

Making an Object’s Layer Current

®  This function is very useful when there are too many layers in your drawing
or you see an object in your drawing, but you do not know in which layer
this object resides in.
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= What you want to do is to make this object’s layer the current layer. To do
SO you must:
* Make sure you are in the Home tab on the Ribbon, and, using the
Layers panel, click the Make Object’s Layer Current button.

2@ 22 55 ﬁ
Uns Laver Stats .

Q -4 Make Object’s Layer Current
'| Sets the current layer to that of a selected ohiject

[ LAYMCUR

Press F1 for more help

e The following prompt will appear:

Select object whose layer will become current:
(click on the desired object)
Walls is now the current layer.

* Now the current layer is the object’s layer.

What Are the Four Switches of a Layer?

Each layer has four switches, which determine its state.
You can see these switches in both the Layer Properties Manager dialog
box and the layer pop-up list from the Layer panel.
®  These switches are:
e  On/Off
o Thaw/Freeze
¢ Unlock/Lock
¢ Plot/No Plot
®  See the following example:

Status | Mame On | Freeze | Lock | Color Linetype Lineweight Plot S... | P... M., Descr
ray | Q If & W wh. Confinuo..—— Default =

= [-ﬂppliancr:s Ky_) :CI & M gr.. Continug.. —— Default @}_ﬁ'\

= BDRTXT B3 = W m.. Continuo.. —— Default = I

Vg BRDTITLE 8 o g [ red  Continuo.. —— Default (=]

P {Cabinetr',' Q i & 95 Continug.. —— Default %}F‘

Eeg DB - Windows B o M blue Continuo.. —— Default =

= Deck ot & M ovan Continuo.. —— Default o

= Defpaints I @ M wh.. Continug.. —— Default =]

= Dimensions o @ M red Continuo.. —— Default =]

& Doors ot @ M 155 Continuo.. —— Default =]

= Lighting ok & M red Continuo.. —— Default 2

= Power ! Tf & M m.. Continuo.. —— Default =]

= Schedules o & M wh.. Continuo.. —— Default =)

= Stairs - & M 203 Continug.. — Default =]

Eeg Text :O: & M wh.. Continuo.. —— Default @

= Viewports Ik & M wh.. Continug.. —— Default =]

Eeg walls ok @ M wh.. Continuo.. —— Default =]

£ il | b
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In the preceding example, you can see that:

e The Appliances layer is On, Thaw, Unlocked, and Plot.

e The Cabinetry layer is Off, Frozen, Locked, and No Plot.

These four switches are independent from each other.

By default, the layers are On, Thaw, Unlock, and Plot.

When you turn a layer off, the objects in it will not be shown on the screen,
and if you plot the drawing, the objects will not be plotted. However, the
objects in this layer will be counted in the total count of the drawing and the
drawing size will not change.

When you freeze a layer, the objects in it will not be shown on the screen,
and if you plot the drawing, the objects will not be plotted. Also, the objects
in this layer will not be counted in the total count of the drawing; therefore,
the drawing size will be less.

When you lock a layer, none of the objects in it are modifiable.

When you make a layer No Plot, you can see the objects on the screen, but
when you issue a Plot command, these objects will not be plotted.

Three of these switches can be changed using both the Layer Properties
Manager dialog box, and the layer pop-up list from the Layer panel. The
fourth switch, Plot/No Plot, can be changed only from the Layer Properties
Manager dialog box.

To change the switch, simply click it.

You cannot freeze the current layer, but you can turn it off. See the following

dialog box:

Bl | ayer - Cannot Freeze

This layer cannot be frozen because it is the current layer.

‘fou can tum off the cumrent layer instead of freezing it, or you can meke a different layer the
current layer,

You should be careful when you turn the current layer off because each and
every time you draw a new object it will disappear. Therefore, when you
try to turn the current layer off, AutoCAD will issue the following warning
message:

M Layer - Current Layer Off E]

The current layer will be turned off. What do you want to do?

+ Tumn the current layer off
Objects that you create from now on will not be displayed in the drawing until
you tum the layer back on.

% Keep the current layer on
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What Is Layer Previous?

While you are working in AutoCAD, you will change the state of layers a
lot, which means you need a tool to help you return to the previous state
quickly.

Layer Previous helps you do that.

Make sure you are in the Home tab on the Ribbon, and, using the Layers
panel, click the Previous button:

%55 %%%%LE
—| B

Unsaved Layer S

(;) ﬁ E’I . B Previous

Undoes the last change or set of changes made to layer settings

[ LAYERP

Press F1 for more help

AutoCAD will report the following statement:

Restored previous layer status

i 0 |

While you are in the Layer Properties Manager palette or layer pop-up list
from the Layer toolbar, and you make several changes on several switches
for several layers, AutoCAD considers them all as one action. Thus, they will
all be restored in one Previous command.

What Is Layer Match?

Layer Match converts objects from one layer to another.

You can use the Layer Match tool to help you unify objects belonging to
different layers.

Make sure you are in the Home tab on the Ribbon, and, using the Layers
panel, click the Match button.

%g%g%%%%.
Lay

Unsaved State -~ &

Q 117 & I Match
Changes the layer of a selected object to match the destination layer

[y LAYMCH

Press F1 for more help
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The following prompt will appear:

Select objects to be changed: (Select the desired objects
and once you are done, press [Enter])
Select object on destination layer or [Name]:

Once the command is done, you will see a message similar to this:

8 objects changed to layer “Dimensions”

LAYER FUNCTIONS

e
owo

Exercise 14

1.
2.
3.

10.
11.
12.

13.

Start AutoCAD 2010.

Open the file Exercise_14.dwg.

Change the object’s layers as follows:

a. Change the layer of the two circles from 0 to Shaft.

b. Change the layer of the two arcs from 0 to Body.

c. Change the layer of the lines from 0 to Base.

Using the Status Bar, switch on Show/Hide Lineweight, to see the objects
displaying the assigned lineweight.

Lock the layer Shaft and then try to erase the objects in it. What message do
you receive from AutoCAD?

Unlock the layer Shatft.

Using the Make Layer Object’s Current button, select one of the
centerlines. Which layer becomes current?

Click the Layer Previous button twice. What happens?

Try to freeze the current layer. What message do you receive from
AutoCAD?

Try to rename layer 0? What message do you receive from AutoCAD?
Rename layer Centerlines to be Center_lines.

Try to delete the layer Shaft. What message do you receive from AutoCAD?
Why?

Save the file and close it.
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3.6 QUICK PROPERTIES, PROPERTIES, AND
MATCH PROPERTIES

Earlier in this chapter, we learned that each object inherits the properties
of the layer that it resides in. By default, the settings of the current color,
linetype, and lineweight is BYLAYER, which means that the object follows
the layer it resides in.

This makes controlling the drawing easier, because it is easier to
control a handful of layers than it is to control hundreds of thousands of
objects. We recommend you do not change these settings under normal
circumstances.

However, sometimes we may need to change some of the properties. To do
that we can use three commands. They are:

* Quick Properties

* Properties

* Match Properties

Quick Properties

Quick Properties is a function that will pop up automatically when you
select any object.

By default, this command is always on, if not, you can turn it on from the
Status Bar:

I?ﬂlﬁlil@l‘ﬂaﬂ&@ﬂE

Quick Propertiss

To start the Quick Properties command simply click any object and the
following small panel will appear:

arc V|
|

Color | W EBylayer
Layer Lighting |
Linetype EvlLayer |
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= In this panel you can change the color, layer, and linetype. If you move the
mouse over any of the two sides, it will expand just like the following:

L&

Calor W EylLaver

Layer Lighting

Linetype — BvLayer
Center & 156,35

Zenter an3, 04

Radius 2 68

Properties

®  The easiest way to initiate the Properties command is to select the desired
object(s) and then right-click. When the shortcut menu appears, select
Properties. Now you will be presented with two possibilities:
e The selection set you made consists of different object types (lines, arcs,
circles, etc.). In this case, you can only change the general properties of
these objects. The following will appear:

x
fo | |anaim
(5
Color BrLayer
Laver *WARIES*
Linetype Y ARIES®
Linetype scale 1,00
Plat style By Zolar
Lineweight — Bylayer
o Hyperlink
=
H -
o Makerial ByLaver
=%

* However, if you choose the upper pop-up list, you will see the following:

i & [ |

x
L3
(5]

FIOT ST Ty T

Lineweight —— Bwlaver
Hyperlink

Material Ervlaver

i3 Properties
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* You can filter the objects you select by selecting the type of object desired.
You can change any or all of the properties.

e The selection set you made consists of a single object type. In this case,
you can change the general properties and the object-specific properties.
The following will appear:

x
Jr |Line (62)
=

Calar ByLaver

Laver FWARIES*

Linetype — Bvlaver
Linetype scale 1,00

Plot style ByColar

Lineweight — Bylaver
Hyperlink

Thickness 0.00

Material . ByLayer

Start x ' Y ARIES*
Start ¥ FYARIES*
Stark 2 0.o0
End *YARIES*
End ¥ *YARIESH
End 2 0.00
Delta & AR ES*
P Delka ¥ #YARTES*
= Delta T 0.00
g- Length *ARIES*
a Angle Y ARIET*

ot ® Properties is a palette, which means all the things we learned about the
Layer palette are applicable here.

Match Properties

= Match Properties is useful if you opened a drawing and found that the
creator of the drawing did not use the BYLAYER.

= For example, you find a green line residing in a red layer and a dashdot circle
in a layer with continuous linetype.

®  The best way to correct this is to try to find one object in each layer that has
the right properties and then match the other objects to it.
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®  Make sure you are in the Home tab on the Ribbon, and, using the
Clipboard panel, click the Match Properties button.

T
g
L
-3
=]

Match Properties
Applies the properties of a selected object to other objeds

[ MATCHPROP

Press F1 for more help

= AutoCAD will give the following prompt:
Select source object:

Click on the object that has the right properties.
= The cursor will change to a brush shape:

-
= AutoCAD will then prompt:

Select destination object(s):

®  Click on the objects you want to correct. Once you are done, press [Enter].

QUICK PROPERTIES, PROPERTIES, AND MATCH PROPERTIES

e
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Exercise 15

1. Start AutoCAD 2010.
2. Open the file Exercise_15.dwg.

3. We accidentally drew all objects in layer 0. Using all of the commands you
have learned, put each object in its correct layer.

4. Save the file and close it.

CREATING OUR PROJECT (METRIC)

e
d@%

Workshop 1-A
1. Start AutoCAD 2010.

2. Close any open files.
3. Create a new file based on the acad.dwt template.
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4. Double-click on the mouse wheel to Zoom Extents.

5. From the Application Menu, select Drawing/Units and make the following
changes:

a. Length Type = Decimal, Precision = 0
b. Angle Type = Decimal Degrees, Precision = 0
c. Unit to scale inserted content = Millimeters

6. Assume that one AutoCAD unit = 1 mm and you have a 30 x 20 m plan you
want to draw. With these measurements, your limits will be:

a. Lower left-hand corner = 0,0

b. Upper right-hand corner = 30000,200000
7. Type Limits in the Command Window, and set the limits accordingly.
8. Double-click on the mouse wheel to Zoom Extents to the new limits.
9. Create the following layers:

Special
Layer Name Color Linetype Remarks
Frame Magenta Continuous
Walls Red Continuous
Doors Yellow Continuous
Door_Swing Yellow Dashed
Windows 150 Continuous
Centerlines Green Dashdot
Bubbles Green Continuous
Furniture 41 Continuous
Staircase 140 Continuous
Text Cyan Continuous
Hatch White Continuous
Dimension Blue Continuous
Viewports 8 Continuous No Plot

10. Save the file in the Metric folder (in the copied folder from the DVD) as
Workshop_01.dwg.
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CREATING OUR PROJECT (IMPERIAL)

e
owc

Workshop 1-B

Uk o=

Start AutoCAD 2010.

Close any open files.

Create a new file based on the acad.dwt template.

Double-click on the mouse wheel to Zoom Extents.

From the Application Menu, select Drawing/Units and make the following
changes:

a. Length Type = Architectural, Precision = 0'-0"

b. Angle Type = Decimal Degrees, Precision = 0

c. Unit to scale inserted content = Inches

Assume that one AutoCAD unit = 1 inch and you have a 70" x 60' plan you
want to draw. With these measurements your limits will be:

a. Lower left-hand corner = 0,0
b. Upper right-hand corner = 70',60'
Type Limits in the Command Window and set the limits accordingly.

Double-click on the mouse wheel to Zoom Extents to the new limits.
Create the following layers:
Special
Layer Name Color Linetype Remarks
Frame Magenta Continuous
Walls Red Continuous
Doors Yellow Continuous
Door_Swing Yellow Dashed
Windows 150 Continuous
Centerlines Green Dashdot
Bubbles Green Continuous
Furniture 41 Continuous
Staircase 140 Continuous
Text Cyan Continuous
Hatch White Continuous
Dimension Blue Continuous
Viewports 8 Continuous No Plot
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10. Save the file in the Imperial folder (in the copied folder from the DVD) as

Workshop_01.dwg.

CHAPTER REVIEW

1.

Layer names can:

a. Have up to 255 characters.

b. Include spaces.

c. Have letters, numbers, hyphens, underscores, and dollar signs.
d. All of the above.

There are different length units in AutoCAD.
What do you need to know to set up limits in a file?

a. The paper size you will print on.

b. The longest dimension of your sketch in both X and Y.

¢. The measure of each AutoCAD unit.

d. BandC.

Only the first seven colors can be called by name and number.
a. True

b. False

What is true about linetypes in AutoCAD?

a. They are stored in acad.lin and acadiso.lin.

b. They are loaded in all AutoCAD drawings.

c. If I need to use a linetype I have to load it first.

d. AandC.

If you assign a lineweight to a layer, and on this layer you draw lines, you
need to click on from the Status Bar to see this lineweight
on the monitor.

You can only change the properties of nonsimilar objects

using the Properties command.

CHAPTER REVIEW ANSWERS
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Chapter CoOMMANDS

In This Chapter
Introduction

The Offset Command
The Fillet Command
The Chamfer Command
The Trim Command
The Extend Command
The Lengthen Command
The Join Command

SO

4.1 INTRODUCTION

So far, we have learned four drawing commands (Line, Arc, Circle, and
Pline).

These alone can only help you accomplish 20% of your drawing.

Also, if you think that each and every line (or arc, or circle) should be drawn
by you, you are wrong!

In this chapter, we will discuss seven commands that will help us construct
the most difficult drawings in no time.

These commands are:

The Offset command creates parallel copies of your original objects.
The Fillet command allows you to close unclosed shapes either by
extending the two ends to an intersecting point or by using an arc.

The Chamfer command is exactly the same as the Fillet command,
except this command will create a slanted edge.

The Trim command allows some objects to act as cutting edges for other
objects to be trimmed.

The Extend command allows you to extend objects to a boundary.
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* The Lengthen command allows you to extend or trim length from an
existing line.

e The Join command allows you to join similar objects (lines to lines,
polylines to polylines, etc.).

4.2 THE OFFSET COMMAND

The Offset command will create a new object parallel to a selected object.
The new object (by default) will have the same properties as the original
object and will reside in the same layer.

There are two methods used in offset:

e Offset distance

e Through point

Make sure you are in the Home tab on the Ribbon, and, using the Modify
panel, click the Offset button.

+ BORA B
O

o
=
-
Maodify -

Dffset

Creates concentric dircles, parallel lines, and parallel cunves

[y OFFSET

Press F1 for more help

The following prompt will appear:

Current settings: Erase source=No Layer=Source
OFFSETGAPTYPE=0

Specify offset distance or [Through/Erase/Layer]
<Throughs>:

Offset Distance

If you want to use this method, you should know the distance between the
original object and the parallel duplicate (i.e., the offset distance).

Then, select the object that will be offset.

Finally, specify the side of the offset by clicking to the right or left, up or
down, etc.

The prompts will be as follows:

Specify offset distance or [Through/Erase/Layer]
<Through>: (type in the desired distance)
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Select object to offset or [Exit/Undo] <Exit>:
(select a single object)

Specify point on side to offset or
[Exit/Multiple/Undo] <Exit>: (click in the desired side)

The command will repeat the last two prompts for further offsetting.
= To end the command, press [Enter] or right-click.

Through Point

= With this method, there is no need to know the distance but you should know
any point that the new parallel object will pass through.
®  The prompt will be as follows:

Specify offset distance or [Through/Erase/Layer]
<Through>: (type t and press [Enter])

Select object to offset or [Exit/Undo] <Exits>:

(Select a single object)

Specify through point or [Exit/Multiple/Undo] <Exit>:
(Specify the point that the new image will pass through)

®  The command will repeat the last two prompts for further offsetting.
To end the command, press [Enter] or right-click.
®  Here is an example:

Refrre After

Multiple

= With both of the preceding methods you can use the Multiple option.
®  Instead of repeatedly selecting the object and specifying the side, the
Multiple option will allow you to specify only the side of the offset.
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®  The prompt will be as follows:

Specify offset distance or [Through/Erase/Layer]

<Through>: (Select either method)

Select object to offset or [Exit/Undo] <Exit>:

(Select a single object)

Specify through point or [Exit/Multiple/Undo] <Exit>:

(Type m and press [Enter])

Specify point on side to offset or [Exit/Undo] <next
object>: (simply click on the desired side, and you can keep
doing the same, once you are done, press [Enter])

Undo

®  You can use the Undo option while you are offsetting to undo the last
offsetting action.

= AutoCAD® will recall the last offset distance, so there is no need to keep
typing it unless you want to use another value.
The Offset command will produce a bigger or smaller arc, circle, or polyline.
You can right-click to show shortcut menus displaying the different options
of the Command Window.

= Inthe Offset command, you can use only one offset distance. If you want another
offset distance you must end the current command and issue a new Offset
command. (We hope to see in the next versions of AutoCAD, Offset commands
that will allow the user to use more than one offset distance per command.)

OFFSETTING OBJECTS

e
owc\

Exercise 16

1. Start AutoCAD 2010.

2. Open the file Exercise_16.dwg.

3. Offset the walls (magenta) to the inside using the distance = 1'.
4

Offset the stairs using distance = 1'-6" and using the Multiple option to
create eight lines representing eight steps.

o

Explode the inner polyline.

&

Offset the right vertical line to the left using the through point method and
the left endpoint of the upper-right horizontal line.

7. Offset the new line to the right using distance = 6".
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8. The new shape of the plan should look like the following:

Il

1L

9. Save the file and close it.

4.3 THE FILLET COMMAND

= Ifyou have the following:

®  And you want them to look like this:

= Or, you want them to look like this:
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Then you need to use the Fillet command.

Issue the Fillet command by selecting the first object and then the second

object. It is a very simple AutoCAD command.

The Fillet command works with two different settings:

¢ Radius = 0 will create a neat intersection.

e Radius > 0 will do the same except it will use an arc rather than a corner
point.

When you close the shape with an arc, what will happen to the original objects?

To solve this issue, the Fillet command works in two different modes:

e In Trim mode, the arc will be produced, and the original objects will be
trimmed accordingly.

e In No trim mode, the arc will be produced, but the original objects will
stay intact.

Here is an example:

—_—
\\\

Refore Afrer with Trim
—_—
N\
Refnre Afrer with Nn Trirm:

Make sure you are in the Home tab on the Ribbon, and, using the Modify
panel, click the Fillet button.

b, BORE:
O & At

M
ove _é ﬁﬁ:{’ EE

|
ﬂ Char| Fillet

Rounds and fillets the edges of objects

ek FILLET

Press F1 for more help




4.3 The Fillet Command 91

i o

®  The following prompt will appear:

Current settings: Mode = TRIM, Radius = 0.0000
Select first object or [Undo/Polyline/Radius/Trim/
Multiple]:

®  The first line reports the current value of the mode and the radius.
®  Choose between the different options: Radius, Trim, Multiple, and
Undo.

Radius

= To set a new value for the radius, the following prompt will appear:

Specify fillet radius <0.0000>: (type in the new radius)

Trim

®  To change the mode from Trim to No trim, or vice versa, the following
prompt will appear:

Enter Trim mode option [Trim/No trim] <Trim>: (type t, or n)

Multiple

= By default, you can perform a single fillet per command by selecting the first
object and the second object.

= If you want to perform multiple fillets in a single command, you have to
select the Multiple mode first.

Undo

= You can use the Undo option while you are filleting to undo the last filleting
action.

= When you fillet with a radius, the radius will be created in the current layer.
Make sure that you are in the right layer.

®  To end the command when you use the Multiple option, press [Enter] or
right-click.

= Evenif R > 0, you can still fillet with R = 0. To do so, simply hold the [Shift]
key and click on the desired objects. Regardless of the current value of R,
you will fillet with R = 0.

®  You can use the Fillet command to fillet two parallel lines with an arc.
AutoCAD will calculate the distance between the t